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Introduction

Powerline Offline Reader for Windows is a "One QWK at a time" OLR with the facility to save 
messages to a database divided into Folders.  Replies created with the program are also 
automatically saved into a special folder reserved for this purpose.

To read a QWK mail packet, a list of files is presented from which to choose, with the ability to alter 
the search pattern or directory.  

Having chosen the QWK packet POW calls PKUNZIP to extract the data.  This data is then read and 
internal tables created which are used later to select conferences etc.  

If a corresponding REP packet is found in the specified replies directory(see later) it is checked for 
date/time with respect to that of the QWK pkt, and an option provided to delete it if it's earlier ie. the 
user may have already uploaded it.  If it exists the REP pkt is then unzipped and the replies made 
available in the reader for viewing or editing.  Replies are rezipped into a REP pkt using PKZIP when 
a new QWK pkt is chosen to view or on exit.  If you are making a lot of replies an option is provided 
(from the File Menu) to save them back to REP, for safety.

Context sensitive Help is available from most windows/dialogs/menu items by pressing F1 key.

POW was written in Microsoft Visual Basic v3.0 Professional Edition & requires VBRUN300.DLL.



Installation

Create a directory for the program and copy POW.EXE, POW.HLP, POW.WRI, and the other files 
extracted from the ZIP into it, except as follows:-  Put GRID.VBX and CMDIALOG.VBX into the 
Windows\System directory.  Take care not to replace any newer versions of these files that are 
already there.  POW also uses COMMDLG.DLL (supplied with Windows, same directory).  
(TAGLINES.POW should later be moved to the Data directory which may be created by POW - see 
below.)

If you do not already have it, obtain a copy of VBRUN300.DLL (not included in ZIP) and put it in the 
Windows\System directory.  PKZIP.EXE & PKUNZIP.EXE (version 2) are also required and should be 
available from the DOS path (or edit the POWZIP/POWUNZIP PIFs - see below).  VBRUN300.DLL 
and the PK programs are available from most BBS's and CompuServe.

Decide on a directory where the program's data files will reside.  These are the Folders data and 
index files.  If the directory does not exist it will be created by the program.  

A temporary "work" directory is also required, where temporary files used by POW are kept.  This will 
be created by POW.  Program speed is improved if this is on RAMDRIVE.

The other directory paths to set up are where your QWK and REP files reside, these too will be 
created if they do not already exist.

POW will create the file POW.INI in the Windows directory when first run.  This may later be moved to 
the program directory if desired.  POW will search the program directory first.  
POW does not modify WIN.INI or any other Windows file or AUTOEXEC.BAT etc.

POW may be activated from an icon in Program Manager in the usual way.  An icon is available in the 
EXE (and another is supplied as POW.ICO).  The Path should be the directory containing POW.EXE.  
There are no Command Line Parameters.

POWZIP.PIF & POWUNZIP.PIF

As supplied these run PKZIP or PKUNZIP in a window and assume PKZIP/UNZIP EXE files are on 
the DOS Path.  If desired the Program Filename may be changed to include the full path to the PK 
progs and then these can be anywhere on the system.  This may be useful if running POW on a 
network or under OS/2, Windows NT etc.  The Optional Parameters & Startup Directory should be 
left empty.  In the event of unresolvable problems, these PIF files may be removed from the POW 
directory and POW will use the default Windows PIF to run PKZIP/UNZIP as in earlier versions.  
However, in this case, the PKZIP/UNZIP EXE files must be on the DOS Path, and PKZIP/UNZIP will 
run full-screen.



The Directories Dialog.

When POW is first run, the directory paths should be set up in the Directories Dialog from the Options 
Menu as follows:-

QWK File Pattern Search pattern for QWK files - eg. *.QW? or *.Q??
QWK Directory Path to the directory containing your QWK pkts

Replies Directory Path to the directory containing your REP pkts

Save Directory Path to the directory for saving text files and messages.

Data Directory Directory for the Folders Data and index files

Work Directory Directory for temporary files.  All files in this dir will be deleted on exit or when
reading a new QWK packet.  The directory itself is removed on exit if on the 
same drive as the EXE.

Attachments Directory to which attached files are written when detached from incoming 
messages and is also the default directory from which files may be attached 
to messages.

Click on the Save button (or Alt-S on keyboard) to save these settings.

A file, POW.INI, is created in the Windows directory.  This contains these and other settings/options.  
No changes are made to WIN.INI or any other Windows files. 

The Main Menu

On line Help is available by highlighting the menu item and pressing F1.

  File
  Edit
  View
  Options
  Help

File Menu

Open QWK Packet Displays Dialog box from which QWK pkt is selected

Attach File to REP Displays the Attachment dialog where files may be attached to messages.
Save Replies Save Rep pkt back to HD (if one exists)
Kill (Delete) REP Kill all replies/msgs and delete the REP file if it exists

Detach File from msg(Only shown if incoming msg has an attached file)  This copies an attached 
file into the Attachments Directory (see Directories Setup) and gives it the 
original name when attached.  A warning is given if the file already exists.

Save Msg to File Save the msg to a file via a SaveAs dialog where an existing file may be 
selected for Appending or a new file name entered.

Print Msg Print a msg using the Font etc. in the Printer Font in the Options 
Menu.

Exit Reader Save all data and Exit



Edit Menu (Items marked * available Only if Msg Edit Option enabled)

Undo Undo last edit *

Cut Cut marked text to Clipboard *
Copy Copy marked text to Clipboard
Paste Paste Clipboard text to msg *
Delete Delete marked text *

Select All Select (mark) all text in message.

Steal Tagline Copies first line of marked text into a one line text editing box in Tagline Editor dialog. 
The tagline may be edited before adding it to the Taglines list using the Add button.

View Menu

Folders Show list of Folders - select a folder to view

Conferences Show list of conferences
RepPkt List of replies in REP pkt

Bulletins Bulletin list

NewFiles New Files list
News BBS News

Welcome Welcome (Hello) screen
Goodbye Goodbye screen

Session Text of the Mailrun Session

Options Menu

Directories Set up directories for QWK, REP, Data and temp work
Toggles Enable or Disable features such as warning beep 
Sort Options Sort field etc. for QWK list, Message lists etc.

Font (msgs) Select the Font used to display messages, including Size, Bold etc.
Printer Font Select the Font used to print text, including Size, Bold etc.
Colors Displays a dialog from which the required colour change may be 

made.  Colours and Fonts etc. are saved in POW.INI and used in later runs.

Maintain Database Displays Folders Database Statistics & Maintenance box from which the 
Folders database file may be packed, purging deleted messages.

Add/Drop Confs  Calls the Door Control dialog which shows a list of conferences from which 
the user may choose Add, Drop or Reset.  The Reset button has an 
associated Text box into which the message number may be put.  Use a 
negative number to select the last so-many messages to read.

Help Menu

Help Contents Display help at the Contents page
Keyboard Use of Keyboard
How to use Help Instructions for using the Windows Help system
Read DocumentationCall Write to read the doc
About Program Info



ButtonBar

Buttons provide the following functions:-

Exit Exit POW and return to Windows.  Same as File/Exit

QWK Call the QWK File Open Dialog. Same as File/Open QWK Pkt

Conf Show the Conference List. Same as View/Conferences

REP Shows replied in REP Pkt. Same as View/RepPkt

Fold Shows the Folder List. Same as View/Folders

Art Calls the Viewing Screen to show msg in Text or Graphics (ANSI Art).

Tag Copies first line of marked text into a one line text editing box in Tagline Editor dialog.  The 
tagline may be edited before adding it to the Taglines list using the Add button.

Send (REPLIES Folder Only)  Send reply/msg again.

Write Enter a new message into the REP pkt.  Calls the Editor. (see also Reply below)

Reply Either marked text or all of the msg is converted to a quote and entered into the internal editor
where a reply may be written.  Also displayed above the edit box is the reply header.  Certain 
fields of this may be edited or info selected from pick lists.

Edit (Replaces Reply for "REP" or "REPLIES Folder")  Edit reply/msg.

Save Save the message to a folder.  A list of folders is shown from which to choose, or a new folder
may be created.

Kill (Folders and REP only)  Kill (delete) the current message in the folder (or REPlies).  Msgs 
marked as deleted are not displayed nor count towards the number of msgs in the Folder.  
Deleted msgs may be purged from the Folders data file using Pack Database from the 
Folders Statistics & Database Maintenance dialog from Options/Maintain Database menu.

Index Displays a list of the messages in the current conference, folder or REP packet.  This also 
shows whether a message has been read, saved, or replied to and if private.

Prev Go to previous message in conference/folder/REP if it exists.  If first msg in a conference this 
will go on to the previous conference.  Optionally, this feature is also available when reading 
folders.  "Allow Next Folder" in Options/Toggles dialog.

Next Go to next message.  If last msg in a conference this will go on to the next conference.  
Optionally, this feature is also available when reading folders.

Main Window Keyboard Usage

Underlined letters on the Button Bar indicate keys to press as an alternative to clicking on the button 
with the mouse.

PgDn/PgUp keys page down and up in msg.  

Space bar pages down till the bottom of the msg then goes to next msg (same as Next button).

P , < - keys go to Previous msg.  N . > + keys go to Next msg.



The QWK File Open Dialog

This Dialog is used to select a QWK mail packet for viewing (or deleting).
A table gives the following information:-
 Filename 
 Size 
 Date & Time
 Msgs in QWK pkt 
 % Read - (of messages)
 Number of Personal msgs
 Number of msgs Replied to

The directory and drive may be changed in the usual way and also the file search Pattern.  This uses 
the usual DOS wildcards.

To select a QWK file select it and click on OK or double-click on the table entry.

 Buttons:-
OK Read selected QWK pkt or enact change of Pattern, Directory or Drive.

Update Update file list (if you've altered things by switching out to File Manager etc.)

Hide Hides selected file by renaming to BBSID.!01.  Where BBSID is the name the BBS 
uses for QWK & REP pkts.  Earlier renamed files are renumbered to make room - up 
to 99.  When 99 files have been renamed/renumbered the BBSID.!99 file is deleted 
and all others moved up.  If you want to keep fewer than 99 renumbered files per 
BBS, you can put KeepNum=xx in the [Misc] section of POW.INI, where xx is 1-99.  
(See Advanced Options below.)

Kill Kill (Delete) selected QWK file.

Cancel Return to Main Window.

The Conference List

This is a list of conferences which contain messages in the current QWK packet.  The fields comprise 
the Number, Name, number of messages and number of UnRead messages.  
Personal messages also appear in a special PERSONAL section.

Buttons 
Read Read messages from first in conference (may be sorted by subject)
Index List the messages (may be sorted by subject)
Close Close conference list

The Folder List

This is a list of Folders which the user has created plus the special REPLIES folder which contains 
copies of replies created with POW.  This is used either to view messages already saved or to select 
a folder in which to save the currently displayed message.

Fields are:- Number, Name, number of messages saved in each folder.

Buttons:-
Read Read messages from first in folder (may be sorted by subject)
Index List the messages in the folder (may be sorted by subject)
Save Available when saving message to a folder

Add Add a new folder
Edit Edit the name of the selected folder
Delete Mark selected folder (if empty) as "Unused" and delete associated index file.
Close Close the Folder List and return to Main Window

Message Lists



A list of the messages may be displayed for either Conference, Folder or REP pkt.  

The fields are:- MsgNum, From, To, Subject, Flags.  

In the case of the conference lists the flag column shows whether the msg has been Read, Saved to 
folder, Replied to, is Private, or has Attached file.

The Directories Dialog.

This is used to change directory paths or the search pattern used to find QWK packet files.  The input 
fields are divided into two sections.  Changes to fields in the top section will have immediate effect but
any changes made in the other will require a program restart.

QWK File Pattern Search pattern for QWK files - eg. *.QW? or *.Q??
QWK Directory Path to the directory containing your QWK pkts

Replies Directory Path to the directory containing your REP pkts

Save Directory Path to the directory for saving text files and messages.

Attachments Directory where attached files are written to when detached from incoming 
messages and is also the default directory from which files may be attached 
to messages.

____________________________________________________________________

Data Directory Directory for the Folders Data and index files

Work Directory Directory for temporary files.  All files in this dir will be deleted on exit or when
reading a new QWK packet.  The directory itself is removed on exit if on the 
same drive as the EXE.

Click on the Save button (or Alt-S on keyboard) to save these settings.

A file, POW.INI, is created in the Windows directory.  This contains these and other settings/options.  
No changes are made to WIN.INI or any other Windows files.

Directories will be created by POW if required (including any intermediate non-existing dirs). 



The Toggles Dialog

Enable Beeps
Warning Turn warning sounds on/off
Personal msg To you Beep if To field matches User Name
Message From you Beep if From field matches User Name

Message Reading
Read ALL Next shows next msg whether already read or not.
Unread Only Next shows next Unread msg
Continue to Next Conf "Next" continues to next Conference, "Prev" goes back to previous.  

When disabled POW returns to the Conference List after reading last 
msg in Conference.

Continue to Next Folder As for Conferences above but when reading Folders.

General
Show Progress Boxes Turn Progress Boxes on/off.  Users with fast machines may prefer to 

disable these.

Allow Msg Text Editing The Text of an original msg may be edited to facilitate quoted text 
formatting.  eg. a paragraph may be split so that you can reply to 
each part separately.  The editing only affects quoted text and Save 
will copy the original text of the msg to a Folder.

Auto Save Attached Files Automatically save all attached files to the Attachments Directory 
when unpacking the QWK pkt, giving them their original names in the
process.  A warning message is displayed if a file with the same 
name already exists.

Auto ANSIART Automatically invoke ANSI viewing of message if [ANSIART] 
or [ANSI START] is found in the msg.
  

Buttons
 Save Save settings in POW.INI for use in subsequent runs.
 OK  Change settings for this run only, (revert to Saved settings when POW is next run).
 CancelCancel any changes and return.

Sort Options

QWK File Sets the order in which the QWK files are listed in the File Open 
dialog.  Sort on Name or Date/Time - Ascending or Descending.

Conf Msg List Sort by Subject or Number(unsorted)

Folder Msg List Sort by Subject or Number(unsorted)
  

Buttons
 Save Save settings in POW.INI for use in subsequent runs.
 OK  Change settings for this run only, (revert to Saved settings when POW is next run).
 CancelCancel any changes and return.



Change Color Dialog

This consists of a List Box containing a list of colors which may be changed, and buttons Set and 
Cancel/Close.  The Set button calls a standard Windows color dialog.  After setting up the colors as 
desired, the Close button will return to the appropriate Window and change the colors.

The Font Dialog

Font from the Options Menu brings up a dialog box containing a list of Fonts available on your 
system from which an alternative font may be chosen for the message display in the main window.  
The size and bold may be changed too.  Sample text in the selected font and size etc. is shown so 
that you can see the effect before pressing the OK button to make the changes take effect.  A Cancel 
button is also provided.

This allows the user to choose a bigger or nicer looking font than the default Terminal Font.  However, 
please note that only Terminal Font will produce the correct format for the message and properly 
display ASCII chars above 128 such as graphics and the pound sign.  
Unless, of course, you have another fixed font with the ASCII (OEM) character set.
 
The selected Font etc. is saved in the POW.INI file and will be used next time POW is run.

The Folders Database Statistics & Maintenance Window

This displays Folders database information and provides buttons for showing the QWK File Info and 
accessing the Pack Database feature.

The following information about the Folders Database is displayed  :-
Number of Folders.
Total number of messages in the Folders (excluding deleted msgs).
Number of msgs in the REPLIES Folder.
Number of Deleted msgs.

The disk space used is also shown:-
Size of Folders Data file
Bytes used by index (.FDX) files.  (And number of index files)
Estimated extra disk space required to Pack the database.

The QWK File Info shows the information that POW has accumulated about the QWK packets read.  
This includes the BBS ID, Date/Time of file, Number of msgs in pkt, % msgs read, Number of 
Personal msgs, Number of msgs Replied to.  This data is stored in the BOOKMARK.POW file in the 
Data Directory.  This data does not grow limitlessly but by default when there are more than 800 
entries, the list is pruned by 200 (oldest).  If required, these values may be altered by including in the 
[Misc] section of POW.INI:-  QWKInfoLimit=xxx  & QWKInfoPrune=yyy   where xxx is limit (10 - 800)
and yyy is number to prune.   See Advanced Options below. 

Pack Database reads the Folders data file and removes all messages marked as deleted, closing up 
the gaps and building a new file.  At the same time, the Folders index (.FDX) files are rebuilt from info 
in the Folders Data file.

The Mail Door Control dialog

This shows the complete list of conferences (or selected conferences only, depending on the mail 
door setting) available on the BBS (at the time the QWK packet was created) from which the user may
choose Add, Drop or Reset.  The Reset button has an associated Text box into which a message 
number may be put.  This is the message number from which to start.  If you want to read the last N 
messages without knowing the current msg number then use a negative number.  
 eg. -50 will select the latest 50 messages to read in the next QWK pkt.

In the case of the mail door supplying the complete list of conferences and the Session Text feature 
enabled, this may be checked to see which conferences you have currently enabled on the BBS.  Use
Session from the View Menu to view the Session Text.



Replying to Messages (and creating new ones)

You may create a Reply to a message showing in the main window.  Using the mouse or keyboard, 
mark the text you wish to quote, then click on the Reply button or press the R key.  The built-in Editor 
is then loaded and the selected text will be displayed in the Edit Box, reformatted if necessary and 
with leading Quote markers at the beginning of each line.  (See Advanced Options below to change 
the Quote marker style.)  The text cursor is placed below the quoted text.

As an alternative, you may "quote" the whole original message into the editor and then delete parts 
not needed.  This occurs if no text is selected (highlighted).  The Reply button or R key will invoke the
Editor as above.

To create a new message or reply without quoting from the original, click on the Write button or press 
the W key to call the Editor.

Text may now be entered and edited using all the usual Windows editing functions.  
See The Internal Editor for more information.

Saving Replies

Having created your msg/reply as above it is saved to a Replies file for adding to the REP pkt later 
and also copied to the REPLIES Folder, from where it may be recovered if required and re-sent or 
edited as the basis of another message.  This is achieved by selecting Save & Exit from the Editor 
File Menu.  

If you want to send the same or similar message to more than one person you may select Carbon 
Copy from the Editor File Menu, which saves the message as above but remains in the Editor.  The 
recipient's name (and any other particular) may then be changed and the message saved as above.  
To send to several people use the Carbon Copy as many times as required.

Replies created with the Editor are packed into a REP packet file when a different QWK packet is 
selected for viewing or when Exiting the program.  Also, a menu option is provided to let the user save
replies to the REP pkt at any time (for peace of mind when making a lot of replies).

Viewing your Replies

Replies either already in the REP pkt or waiting, may be viewed from either the Menu or the REP 
Button on the Button Bar.  A list is displayed from which a reply may be selected for viewing.  Once 
the message is displayed, it may be edited and saved back if desired.



The Internal Editor

An editor is provided in which to create replies or enter new messages.  In addition to a text editing 
box, the message header is also displayed with the option to change certain fields.  These are To, 
Subject, Conference & Tagline.  

The To, Subject and Tagline fields have associated "Pick Lists".  New items may be added to a list 
by clicking on the adjacent Add button, or an existing item may be selected from the drop-down list.  
The text in these fields may be edited in the usual way.

These "Pick Lists" are saved as text files TO.POW, SUBJECT.POW & TAGLINES.POW in the Data 
directory and may be edited or added to with a standard text editor such as NotePad.

The Conference may be changed by selecting from the drop-down list or by entering the conference 
number in the box.  If there are more than about 3500 conferences, the list is divided into parts and 
another box containing option buttons is provided above the Conf Box to select which part to list.  The 
new part will be read when the list is "dropped-down" for conference selection.

Check boxes may be used to make the message PRIVATE or Request Return Receipt.  A further 
check box makes the Tagline "Fido compliant".

Editor Menu

File   Insert Text, Carbon Copy (no exit), Save & Exit or Exit Editor (Abort - no 
save).

Edit   This provides Windows Clipboard functions plus Undo and Select All, plus 
access to the Signatures dialog box.

Search Find, Find Next and Replace text in msg

Document Provides Format Selected Text and SpellCheck features (SpellCheck requires 
SpelMate.DLL and dictionaries in Windows dir).

Options Provides configuration of the Font used in the Edit Box and the various Colors.  Calls
the Font/Color change dialog.  For correct formatting a fixed pitch font should be used
(default Terminal).  The width of the Edit Box is set so that word wrap occurs at the 
same places as when the msg is packed into the REP.  If the size of font chosen is 
too large for this then the Edit Box it set to fill the Editor Window and a warning is 
displayed.

Help    Shows the appropriate Help sections.

Editor File Menu

Insert Text Allows inserting text from an external file at the cursor.  A File Open common dialog is
called from which the user may select a file to insert.

Carbon Copy Saves the message without leaving the Editor.  This allows the To name to be 
changed and the message saved again if the same or similar message is to be sent 
to more than one person.  For more than two recipients, the Carbon Copy feature 
may be used as often as required.

Save & Exit Saves the message and exits the Editor.  This is the normal means of saving 
messages.

Exit Editor Leaves the Editor without saving, providing an Abort message facility.  
If a message has been edited and not saved (with Carbon Copy), a warning 

message is displayed, with the option to return to Editor.



Edit Box

When the editor is first entered from the Reply button, either selected text or the complete original 
message is reformatted and quoting characters added to the start of each line.  The text cursor is 
placed below the quoted text.  If a new message is to be created (from the Enter button) the Edit Box 
is empty, ready for the text of the new message.

In entering text all the usual Windows editing functions are available.  Text may be cut/copied/pasted 
to/from any other window including other Windows apps or another window in the Reader (eg. the 
original msg).  Most of this information is in the Windows manuals or in the on-line Help.  Terminal font
is used to provide compatibility with other message readers (uses the ASCII char set as opposed to 
the Windows ANSI set).

NOTE:- This editor (and message viewer) supports the Tab function.  (Use Ctrl+Tab to insert a Tab - 
the Tab key alone changes field).  Some other readers do not support the Tab character and other 
users may not receive your message correctly formatted.

The Signatures Dialog

The signatures features provides the facility to have multiple "signature blocks".  These are blocks of 
text held in files which may be appended to the message.  These are normally used to "sign" a 
message with extra bits such as Internet address, where you live etc., but any text may be used.  
(Even a whole msg if you like as an alternative to the Carbon Copy feature.)

The dialog box contains an editing Text Box with option buttons to select the source of the text, a 
Table of Signature Files listing the files available with descriptions, a Description box and buttons 
for Save, Paste & Close.

Text in a msg currently in the Edit Box in the Editor may be marked for use as a "signature block" and 
be copied into a text box in the Signatures Dialog, or new text may be entered directly.

Having copied or entered text into the Text Box and entered a Description, the text may be saved to 
disk using the Save button.  A text file is created in the Data Directory.

Blocks of text saved in this way (or created using another editor if you like) may be viewed in the Text 
Box and inserted at the end of the message in the Editor's Edit Box using the Paste button.  
A signature block may also be entered by using keys Shift+F2 to Shift+F12 whilst in the Editor.  
These keys are listed in the Table of Signature Files with the description.  Note, Shift+F1 is reserved
for on-line help.

Viewing Screen

This is a Window containing a box for viewing Text or Graphics (ANSI colour etc.) plus Option Buttons
to choose Text or Graphics and Colors, File, Print, Stop  and Close Buttons.  

If Text is selected any ANSI code sequences are stripped from the text and the remaining plain text 
displayed in a scrolling Text Box.

If Graphics is selected the ANSI code sequences are obeyed to give colour and cursor positioning 
and displayed in a Picture Box.  Scrolling is available by using the PgUp or PgDn key to page 
up/down by two lines less than the window and the up/down cursor keys to scroll up or down by two 
lines.  RIP graphics are detected and a warning message displayed.  This version of POW will not 
display RIP graphics.

Colors allows changing the Window and text colors.

File provides the facility to save text to a file via a SaveAs dialog where an existing file may be 
selected for Appending or a new file name entered.

Print allows printing a text file using the Font etc. set up in the Printer Font in the Options Menu.

Stop allows the user to stop the display of a Picture before completion.

Advanced Options



All POW Options are kept in the POW.INI file.  Most of these are set from within POW but extra 
options may be added from time to time which are read from the POW.INI but are not included in the 
Options within POW for simplicity of use.  These are detailed below, (showing the default values that 
would apply if the line were omitted from POW.INI).  Use a text editor such as Notepad to add lines as
required.  The [Misc] section may go anywhere in POW.INI but avoid splitting sections (section name 
in square brackets).

[Misc]
QuotePattern=FL>
DefaultQuote=->
KeepNum=99
QWKInfoLimit=800
QWKInfoPrune=200

QuotePattern determines the Quote string used in replies.  The (upper case) FL are converted to the 
initial letter of the First and Last name, other characters are copied directly into the Quote string.  The 
F and L may occur anywhere in the string.  All chars following the = on the line are used, including 
spaces.

DefaultQuote determines the default Quote string used in replies to Internet msgs where POW is 
unable to determine the name of the originator of the msg.  All chars following the = on the line are 
used, including spaces.

KeepNum determines the number of QWK pkts kept by the Hide in the QWK Open Dialog.  If this line
is omitted, the Hide will rename and number up to 99 pkts per BBS.  When a pkt has been 
renumbered to BBSID.!99 it is deleted next time.  This value of 99 may be altered by including the 
KeepNum line in POW.INI.  Any value between 1 and 99 may be used.  (See also Hide in QWK Open
Dialog.)

QWKInfoLimit=xxx and QWKInfoPrune=yyy determine how much information is retained about 
QWK pkts previously read by POW.  xxx determines how many info records are kept before the older 
records are pruned.  Once this limit is reached, yyy determines how many records are removed 
(pruned) from the beginning of the list when POW is next run.  It is recommended that yyy be greater 
than the number of new QWK files read per session.  The value of xxx-yyy gives the minimum number
of records kept and should be greater than the number of QWK pkts  likely to be kept on your system, 
including those renamed using the Hide feature in QWK File Open.  If QWK Info records relating to 
existing QWK pkts are discarded then the info about number of msgs etc. will not be displayed in the 
QWK File Open file list and it will seem as if the QWK has not been read.  However, re-reading the 
QWK will recover the info from the Bookmark info saved in the QWK file.

The default values of 800 and 200 may be quite suitable but users of slower machines may find that 
reading new QWK file names in the QWK directory takes longer and longer as the QWK Info History 
includes many hundred records and POW scans the list for matching entries.  In this case a reduction 
in the values may prove helpful.



Registration Details Dialog 

This is accessed from the Shareware Registration Reminder Screen at startup from the Enter Reg 
Code button.  When you register POW you quote the name which you would like displayed as your 
Registered Name and you will be given a Registration Code to enter into the POW Registration 
Details Dialog.

The Registration Details Dialog consists of two text boxes and two buttons.  Enter your Registered 
Name and Registration Code in the text boxes exactly as specified.  Press OK to make POW check 
the details.  If the code has not been entered correctly an error message is displayed and the entry 
must be re-edited or choose Cancel to close and return to the Shareware Registration Reminder 
Screen.

Registration & Contact Details - Benefits of Registering

UK & Europe
To register POW print out and complete the registration form REGISTER.TXT (this may be done from 
within POW from a Shareware Registration Reminder, or in DOS, COPY REGISTER.ASC > PRN) 
and send together with a cheque or postal order made out to Powerline Systems Ltd for £20 plus VAT 
(£23.50 total) to:-

Powerline Systems Ltd
44 Rydal Way
Ruislip
Middx.
HA4 0RU
ENGLAND

USA & Canada
To register POW print out and complete the registration form REGISTER.USA (this may be done from
within POW from a Shareware Registration Reminder, or in DOS, COPY REGISTER.ASC > PRN) 
and send together with a Check/Money order for $35(US) made out to:

Southland Trading Company
900-91 Howard Avenue
Escondido
CA. 92029
USA

Technical Support may be obtained by contacting the author, Gina Davis, as follows:-
1. Direct Line BBS, London.  
   Call 081 845 8228 (10 Lines) - 8/N/1 - All speeds - Ansi or RIP terminal recommended. 
2. Internet:- gina.davis@ps.com
3. CompuServe UKCOMMS forum, address messages to Gina Davis [70374,1277]
4. CompuServe Mail ID 70374,1277

For site registration or marketing related information please contact Powerline Systems at the address
above, or via a Direct-Line message to 'Sysop', or Internet:- sysop@ps.com or a message on 
CompuServe's UKCOMMS forum addressed to Steve Manners on CompuServe ID 70007,4737

Benefits of registering POW include removal of the Registration Reminders and  your Registered 
Name appears in the About window.  Also, registered users receive highest priority for requests for 
improvements.  Income from registrations enables continued support and development of POW.  

See ReadMe.Txt for last minute changes and further information.

Disclaimer

This an updated Shareware version of POW.  Whilst every effort has been made to test and debug 
this version (and earlier versions have been in general use for several months), no guarantee is given 
or implied that there are no further problems waiting to be found.  Please report any problems to the 
author (see above).  Any feedback is much appreciated.
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APPENDIX A - Limits

Number of QWK Files (per dir) .   200
Size of QWK files . . . . . 4,000,000
Number of Conferences per pkt  10,000
Highest Conference Number . . .  9999
Messages per Conference . . .   1,000
Messages per QWK pkt  . . . .  10,000
Messages per REP pkt  . . . . . 1,000
Characters per Message. . . .  30,000
Number of Bulletins . . . . .   1,000
Characters per Bulletin . . .  30,000

Number of Folders . . . . . . . 1,000
Messages per Folder . . . . . . 1,000
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